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Preface

This guide provides information about how to install Oracle Health Sciences Mobile 
Clinical Research Associate (Mobile CRA) Server application.

This preface contains the following topics:

■ "Audience" on page 2-vii

■ "Documentation Accessibility" on page 2-vii

■ "Related Documents" on page 2-vii

■ "Conventions" on page 2-viii

Audience
This guide is intended for the following job classifications:

■ System Administrators

■ Installation Professionals

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or 
visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents

Oracle Database Documentation
■ Oracle Database Concepts for a comprehensive introduction to the concepts and 

terminology used in this manual

■ Oracle Database Administrator's Guide for information about administering the 
Oracle Database

■ Oracle Database SQL Language Reference for information on Oracle's SQL commands 
and functions
vii



■ Oracle Database Advanced Application Developer's Guide for information about 
developing database applications within the Oracle Database

You can go directly to the documentation section of the OTN Web site at

http://www.oracle.com/technology/documentation

Oracle Business Intelligence Enterprise Edition (OBIEE) Documentation
The Oracle Business Intelligence Suite Enterprise Edition Online Documentation 
Library 11.1.1 documentation set includes:

■ Oracle Fusion Middleware User's Guide for Oracle Business Intelligence Enterprise 
Edition 11g Release 1 (11.1.1) 

■ Oracle Fusion Middleware Metadata Repository Builder's Guide for Oracle Business 
Intelligence Enterprise Edition 11g Release 1 (11.1.1) 

■ Oracle Fusion Middleware System Administrator's Guide for Oracle Business Intelligence 
Enterprise Edition 11g Release 1 (11.1.1) 

■ Oracle Fusion Middleware Scheduling Jobs Guide for Oracle Business Intelligence 
Enterprise Edition 11g Release 1 (11.1.1) 

■ Oracle Fusion Middleware Security Guide for Oracle Business Intelligence Enterprise 
Edition 11g Release 1 (11.1.1) 

■ Oracle Fusion Middleware Developer's Guide for Oracle Business Intelligence Enterprise 
Edition 11g Release 1 (11.1.1) 

■ Oracle Fusion Middleware Integrator's Guide for Oracle Business Intelligence Enterprise 
Edition 11g Release 1 (11.1.1) 

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
viii
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1Before you Begin

This section presents an overview of the Mobile Clinical Research Associate (CRA) 
Server requirements. It also describes the tasks that you must complete before you can 
install the Mobile CRA Server application. This section includes the following topics:

■ Section 1.1, "Technology Stack and System Requirements"

■ Section 1.2, "Prerequisites"

■ Section 1.3, "Media Pack Contents"

1.1 Technology Stack and System Requirements
The requisite technology stack for Oracle Health Sciences Mobile CRA Server is 
provided in the media pack. It consists of the following products:

■ Oracle Database (DB) 11g Enterprise Edition Release 11.2.0.3.0 - 64-bit Production 

■ Oracle WebLogic Server (WLS) 10.3.5

■ Oracle Application Development Framework (ADF) 11.1.1.6

■ Oracle Business Intelligence Enterprise Edition (OBIEE) 11.1.1.6.0

■ Oracle Business Intelligence Administration Tool 11.1.1.6.0 

■ Oracle Internet Directory (OID) 11.1.1.5

■ Oracle Clinical Development Analytics (OCDA) 2.1 and above

■ Oracle Clinical Trial Management System (CTMS) 8.1.1.9 and above

1.1.1 Other Software Requirements

■ Oracle Enterprise Linux 6

■ iOS 4.x

■ Java 1.6

1.2 Prerequisites
Before you install Mobile CRA Server:

Note: OCDA and CTMS are not part of the Media Pack. You need to 
procure them separately.
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Media Pack Contents
■ Install Lightweight Directory Access Protocol (LDAP)

■ Configure Mobile CRA Server and CTMS with LDAP

■ Contact Oracle support to obtain mobile user credentials

1.3 Media Pack Contents
This media pack software section contains the following:

Table 1–1  Media Pack Contents

File Name Contains

MobileCRA_Server.zip Mobile CRA Server files

MobileCRA Server (Directory)

MobileCRA_Server_CDA_Adapter.zip Mobile CRA Server CDA Adapter files

MobileCRA_Server_CTMS_
Adapter.zip

Mobile CRA Server CTMS Adapter files

MobileCRA AdminUI (Directory)

MobileCRAAdminUI.zip Mobile CRA Administration UI

MobileCRA_Server_Database.zip Zip file containing Mobile CRA Server schema creation scripts

HSM_SchemaCreation.sql Control script to create Mobile CRA Server Schemas (without 
OCDA install)

HSM_SchemaCreation_CDA.sql Control script to create Mobile CRA Server Schemas (with OCDA 
install)

HSMRE_1.0_Schema_ddl.sql Control script to create schema object for Mobile CRA Server 
Rules Engine (MCRE) schema

HSMRE_1.0_tables_ddl.sql Script to create table

HSMRE_1.0_synonyms_ddl.sql Script to create synonym

HSMRE_1.0_views_ddl.sql Script to create view

HSMRE_1.0_indexes_ddl.sql Script to create index

HSMRE_1.0_constraints_ddl.sql Script to create constraint

HSMRE_1.0_sequences_ddl.sql Script to create sequence

HSMRE_1.0_comments_ddl.sql Script to create comments

MCRA_RulesEngine_Seed.sql Script for Rule Engine Seed data

HSMRE_1.0_ResetSeq_ddl.sql Script for reset sequence (drop and create new sequence objects)

HSMRE_1.0_schemadrop_ddl.sql Script to drop schema objects

HSMRE_1.0_refresh_mvw.sql Script to create materialized view scheduler

HSCTMS_1.0_Schema_ddl.sql Control script to create schema object for Mobile CRA Server Trip 
Report (MCTR) schema

HSCTMS_1.0_Tables_ddl.sql Script to create table

HSCTMS_1.0_Indexes_ddl.sql Script to create index

HSCTMS_1.0_Constraints_ddl.sql Script to create constraint

HSCTMS_1.0_Sequences_ddl.sql Script to create sequence

TripReport_SeedData.sql Script for Trip Report Seed data

HSCTMS_1.0_ResetSeq_ddl.sql Script for reset sequence (drop and create new sequence objects)

HSMAQ_1.0_schema_ddl.sql Control script to create schema object for Mobile CRA Server 
Advance Queue (MCAQ) schema
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Media Pack Contents
HSMAQ_1.0_tables_ddl.sql Script to create table

DB Scripts (Directory)

HSMAQ_1.0_constraints_ddl.sql Script to create constraint

HSMAQ_1.0_sequences_ddl.sql Script to create sequence

HSMAQ_1.0_CreateQ_ddl.sql Script to create Advance Queue (AQ)

HSMAQ_1.0_PurgeQ_ddl.sql Script to purge AQ

HSMSV_1.0_Schema_ddl.sql Control script to create schema object for Mobile CRA Server 
(MCSV) schema

HSMSV_1.0_tables_ddl.sql Script to create table

HSMSV_1.0_index_ddl.sql Script to create index

HSMSV_1.0_constraints_ddl.sql Script to create constraint 

HSMSV_1.0_sequence_ddl.sql Script to create sequence 

HSMSV_1.0_customtypes_ddl.sql Script to create custom types

HSMSV_1.0_comments_ddl.sql Script to create comments

HSMSV_1.0_ResetSeq_ddl.sql Script for reset sequence (drop and create new sequence objects)

HSMSV_1.0_schemadrop_ddl.sql Script to drop schema objects

OBIEE (Directory)

MobileCRA_OBIEE.zip Zip file containing Mobile CRA Server repository and catalogs

MobileCRA_Server_01.rpd Mobile CRA server repository

dummy.rpd Dummy repository (empty), which is required for merge process

Mobile CRA Operations.catalog Mobile CRA Server Operations catalog

Mobile CRA.catalog Mobile CRA Server catalog (Rules Engine)

Site-At-A-Glance.catalog Site-at-a-Glance reports

Table 1–1 (Cont.) Media Pack Contents

File Name Contains
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2Installing the Database Tier

This chapter includes the following sections:

■ Section 2.1, "Creating Default Schema Users"

■ Section 2.2, "Deploying Mobile Clinical Research Associate Server Schemas (With 
Clinical Development Analytics Install)"

■ Section 2.3, "Deploying Mobile CRA Server Schemas (Without Clinical 
Development Analytics Install)"

■ Section 2.4, "Installing Seed Data"

2.1 Creating Default Schema Users
This section details the default schema users created by the script.

The script:

■ Prompts to enter a password for each user

■ Prompts for OCDA user name and password

■ Assumes that schema user do not exist

2.2 Deploying Mobile Clinical Research Associate Server Schemas (With 
Clinical Development Analytics Install)

To deploy Mobile CRA Server schemas for customers with OCDA installation, 
perform the following:

1. Download and unarchive Mobile CRA_Server_Database.zip to a local folder.

2. Modify the value of the repeat_interval variable in the HSMRE_1.0_refresh_
mvw.sql file to match the schedule of the Mobile CRA Server Rules Engine 
configured in Section 4.1.4, "Customizing the Configuration File".

Table 2–1  Database Schema

Schema Recommended User Name

Mobile Clinical Research Associate (CRA) Server Rules Engine MCRE_ADMIN

Mobile CRA Server Trip Report MCTR_ADMIN

Mobile CRA Server MCSV_ADMIN 

Mobile CRA Server AQ MCAQ_ADMIN

Mobile CRA Server Push Notification Server MCNS_ADMIN
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Deploying Mobile CRA Server Schemas (Without Clinical Development Analytics Install)

2-2 O
You need to schedule this interval before the Mobile CRA Server Rules Engine 
runs. By default, the FREQ=MINUTELY;INTERVAL value is set to 30. 

3. Using SQL*Plus, log in to the Oracle 11gR2 database as SYS user.

4. Execute the following SQL script using SQL*:

HSM_SchemaCreation_CDA.sql

5. Enter the OCDA user name and password when prompted.

6. Enter the passwords for MCRE_ADMIN, MCSV_ADMIN, MCAQ_ADMIN, and 
MCTR_ADMIN schemas user when prompted.

The script creates database objects for MCRE_ADMIN, MCSV_ADMIN, MCAQ_
ADMIN, and MCTR_ADMIN schemas.

2.3 Deploying Mobile CRA Server Schemas (Without Clinical 
Development Analytics Install)

To deploy Mobile CRA Server schemas for customers without OCDA installation, 
perform the following:

1. Download and unarchive Mobile CRA_Server_Database.zip to a local folder. 

2. Using SQL*Plus, log in to the Oracle 11gR2 database as SYS user.

3. Execute the following SQL script using SQL*:

HSM_SchemaCreation.sql

4. Enter the passwords for MCSV_ADMIN, MCAQ_ADMIN, and MCTR_ADMIN 
schemas when prompted.

The script creates database objects for MCSV_ADMIN, MCAQ_ADMIN, and MCTR_
ADMIN schemas.

2.4 Installing Seed Data

2.4.1 Trip Report Seed Data
To install trip report seed data, perform the following:

Note: Ensure that the SQL*Plus is started from the folder where files 
are downloaded.

Note: Passwords will not echo on the screen.

Note: Ensure that the SQL*Plus is started from the folder where files 
are downloaded.

Note: Passwords will not echo on the screen.
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Installing Seed Data
1. From the server/mobile-admin/database folder, execute the TripReport_
SeedData.sql by connecting through a SQL session to the Mobile CRA Server trip 
report schema.

For example, 

SQLPlus> conn <adminui_user>/<adminui_pad>@<adminui_db>

SQLPlus> @TripReport_SeedData.sql

2. Review to ensure that there are no errors. 

If you want to spool the results, execute the spool command. For example, 

SQL> spool abc.log

2.4.2 XSL Seed Data
To install XSL seed data, perform the following:

1. Connect to the server where the Oracle database for Mobile CRA Server is 
installed.

2. Set up the necessary environment so that you can run the Oracle utilities such as 
SQLPlus, imp, and so on.

3. Import the XSL seed data for the out-of-the-box trip reports by using the Oracle 
imp utility in step 4.

4. While importing the XSL seed data, you need to connect to the Mobile CRA Server 
CTMS trip report schema by executing the following command: 

$>imp <adminui_user>/<adminui_pad>@<adminui_db> 
file=server/mobile-admin/database folder/Mobile CRA_xsl.dmp

5. The import command prompts for other parameters. You can accept the default 
values except for the following:

■ Ignore creation error due to existence of schema objects <No>? 

The default value is No. Select Yes, since the table is already created by the 
TripReport_SeedData.sql and to ignore the object already exists error.

■ Import entire file <No>? 

The default value is No. Select Yes to import the complete file.

6. After importing the seed data in Mobile CRA Server CTMS trip report schema, 
perform the following: 

a. Log in to the database using SQLPlus as MCTR_ADMIN schema user.

b. Execute HSCTMS_1.0_ResetSeq_ddl.sql (that is, <localpath>\server\ 
mobile-admin\database\HSCTMS_1.0_ResetSeq_ddl.sql).
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3Installing the OBIEE Tier

This section details the deployment of Mobile CRA Server - OCDA OBIEE repository 
(RPD) in the Mobile CRA Server environment. 

This chapter includes the following sections:

■ Section 3.1, "Creating Backup"

■ Section 3.2, "Before Deploying Mobile Clinical Research Associate Server OBIEE 
Component"

■ Section 3.3, "Configuring OBIEE Admin User"

■ Section 3.4, "Configuring Mobile Clinical Research Associate Server Repository"

■ Section 3.5, "Upgrading OCDA Repository to Add Mobile Clinical Research 
Associate Server Rule Engine Data Source (Required for Installation with OCDA)"

■ Section 3.6, "Merging Repository"

■ Section 3.7, "Deploying Updated OCDA Repository to OBIEE"

■ Section 3.8, "Creating User to Access the New OCDA - Mobile Clinical Research 
Associate Server Repository"

■ Section 3.9, "Deploying Mobile Clinical Research Associate Server Pre-defined 
Alert"

■ Section 3.10, "Deploying Mobile Clinical Research Associate Server Reports Alert"

■ Section 3.11, "Updating OCDA with Mobile Clinical Research Associate Server 
Rules Engine"

■ Section 3.12, "Deploying Site-At-a-Glance Reports"

For information about OBIEE and RPD in Oracle® Health Sciences Clinical 
Development Analytics (OHSCDA), see the following:

■ http://download.oracle.com/docs/cd/E25587_01/index.htm (for Plus 
configuration)

■ http://download.oracle.com/docs/cd/E26474_01/index.htm (for Standard 
configuration)

3.1 Creating Backup
Before deploying Mobile CRA Server OBIEE, back up all OBIEE catalogs, RPD, and 
security profiles.
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Before Deploying Mobile Clinical Research Associate Server OBIEE Component
3.2 Before Deploying Mobile Clinical Research Associate Server OBIEE 
Component

Before deploying Mobile CRA Server OBIEE component, ensure to collect the 
following files and DB user information:

■ Required RPDs

– OCDA Repository: Ensure to make a note of the name, location, and the 
password for RPD (OCDA), which will be upgraded to include Mobile CRA 
Server Alert feature.

– Mobile CRA Server Repository (Mobile CRA_Server_01.rpd): This repository 
contains Mobile CRA Server data source. This is used for Mobile CRA Server 
operations reports and is provided by Oracle. The default password is 
Admin123. 

– dummy.rpd: This is an empty RPD, which does not contain data source. This 
is required for merging process. The default password is Admin123. 

■ Database user name and password for the following schemas:

– Mobile CRA Server

– Mobile CRA Server Rules Engine (This is required only for installation with 
OCDA)

– OCDA (This is required only for installation with OCDA)

3.3 Configuring OBIEE Admin User
To configure OBIEE admin user, perform the following:

1. Look up for OBIEE server in the deployment config file.

a. From the file system, locate Config.xml under Config folder of the main folder.

b. Look up for CdaFeaturedAdapter.wsdlocation variable, the OBIEE server 
name is included in the value. 

2. Log in to WLS Enterprise Manager as admin by entering the URL using the server 
address in Step 1 (for example, http://<server:port number>/console).

3. Click Security Realms.

4. Select myrealm from the list. 

The Settings for myrealm screen is displayed in the right-side window panel.

5. Click Users and Groups.

6. Click Users tab and click New to create a user.

7. Enter the name.

8. Enter the description.

9. Retain the default value in the Provider field.

10. Enter a password of your choice. 

11. Re-enter the password in the Confirm Password field.

12. Click OK to create the user.

13. Assign groups to the user as follows:
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Configuring Mobile Clinical Research Associate Server Repository
a. Click the user Mobile CRA-admin and select Groups.

b. Assign Administrator and BI Administrator groups to the user.

14. Click Save to save the user profile.

3.4 Configuring Mobile Clinical Research Associate Server Repository
To configure Mobile CRA Server RPD to point to Mobile CRA Server database, 
perform the following:

1. Open the OBIEE Administration tool.

Figure 3–1 OBIEE Administration Tool

2. Open Mobile CRA_Server_01.rpd.

3. Enter the password.

Oracle recommends you to modify the password of the RPD provided by Oracle. 
To change the password, perform the following:

■ From the File menu, select Change Password.

■ Enter the old and new password in the respective fields.

4. To configure Mobile CRA Server, right-click on Mobile CRA Server Connection 
Pool, and choose Properties.

Figure 3–2 Connection Pool Properties Screen 1

5. Modify the data source name, user name, and password to the database user 
created for the Mobile CRA Server data model.

■ Enter the data source name in the following format:

(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<hostname>)(PORT=<port>))
(CONNECT_DATA=(SID=<oracle db sid>)))

■ Enter the user name and password for the Mobile CRA Server schema.
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Configuring Mobile Clinical Research Associate Server Repository
6. Repeat Step 5 to redirect Mobile CRA Server database to Rules Engine Data 
Model.

Figure 3–3 Connection Pool Window Screen 2

Figure 3–4 Connection Pool Window Screen 3

7. Save the RPD file.

8. Test your connections by viewing data on one of the tables in the datastore.
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Merging Repository
Figure 3–5 Testing Connections

For example, if you see data return, it indicates that your configuration is working. 

9. Click OK to save.

3.5 Upgrading OCDA Repository to Add Mobile Clinical Research 
Associate Server Rule Engine Data Source (Required for Installation with 
OCDA)

To upgrade OCDA repository to add Mobile CRA Server Rule engine data source, 
perform the following:

1. Refer to Section 3.11, "Updating OCDA with Mobile Clinical Research Associate 
Server Rules Engine" for instructions.

2. Save the created RPD as OCDA_MCRE_01.rpd.

3.6 Merging Repository
To merge RPD, perform the following:

1. Take a backup of the following repository:

■ Updated version of OCDA repository (updated with Mobile CRA Server Rules 
Engine data source) OCDA_MCRE_01.rpd.

■ Mobile CRA Server Repository - Mobile CRA_Server_01.rpd

2. Open the updated OCDA RPD, that is OCDA_MCRA_01.rpd.

Figure 3–6 Opening RPD

3. From the File menu, select Merge. 
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Merging Repository
Figure 3–7 Selecting Merge Option

The Merge Repository Wizard is displayed.

4. Select dummy.rpd in the Original Master Repository.

Figure 3–8 Selecting Repository

5. Enter the repository password for the dummy repository.

6. Select Mobile CRA_Server_01.rpd.

7. Enter the repository password for Mobile CRA Server repository.

8. Retain Save Merged Repository as is and note down the saved merged repository 
name and location.

9. Click Next.

Figure 3–9 Selecting Input Files

A screen is displayed which shows the conflicts.

10. Click the Decision column in the conflict row and select Current. 
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Deploying Updated OCDA Repository to OBIEE
Figure 3–10 Defining Merge Strategy

11. Click Next.

The Merge Repository screen is displayed.

12. Verify that the physical layer has Mobile CRA Server, Mobile CRA database, and 
OCDA data warehouse schemas available in the Physical section.

13. Verify that the Mobile CRA Server and OCDA-DM are available in the Business 
Model and Mapping section.

14. Open Dim - Study in OCDA-DM from the Business Model and Mapping section, 
and verify that the HSM_OBI_STUDY_VW is included in the source.

15. Open Dim - Study-site in OCDA-DM from the Business Model and Mapping 
section, and verify that the HSM_OBI_STUDY_SITE_VW is included in the source.

16. Verify that the Mobile CRA Server and OCDA are available in the Presentation 
section.

17. Verify that the Mobile CRA Server Alert Engine, Study, and Study Site 
presentation tables are available under OCDA.

18. Save the updated OCDA repository (for example, OCDA_MCRE_MCSV_01.rpd). 

3.7 Deploying Updated OCDA Repository to OBIEE
To deploy updated OCDA RPD to OBIEE, perform the following:

1. Log in to Enterprise Manager (for example, http://<server:port number>/em).

2. Navigate to Business Intelligence and select Coreapplication.

3. Navigate to Deployment tab, and then to the Repository subtab.
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Figure 3–11 Coreapplication Screen

4. Click Lock and Edit Configuration to lock the application.

5. In the Upload BI Server Repository pane, choose the RPD file that you want to 
upload, and load the updated OCDA repository (for example, OCDA_MCRE_
MCSV_01.rpd). 

6. Enter the password for updated OCDA repository.

7. Re-enter the password for the updated OCDA repository in the Confirm Password 
field.

8. Click Apply.

9. Click Activate Change.

10. Restart to apply recent changes.

11. Restart all BI components.

Figure 3–12 System Shutdown and Startup Screen

12. Click Yes in the Confirmation window.

Once the restart is complete, a message is displayed indicating that the RPD 
deployment is complete.
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3.8 Creating User to Access the New OCDA - Mobile Clinical Research 
Associate Server Repository

To create a user to access the new OCDA - Mobile CRA Server RPD, perform the 
following:

1. Navigate to the Oracle WebLogic server (for example, 
http://<servername>/console/login/LoginForm.jsp).

2. Navigate to Security Realms and select myrealm.

The Settings for myrealms screen is displayed.

Figure 3–13 Settings for myrealms Screen

3. Click Users and Groups.

4. Click New in the Users subtab.

Figure 3–14 Users Tab

5. Enter the OBIEE user name (for example, Mobile CRA-admin).

6. Enter the OBIEE password.

7. Click OK to create user.

8. Assign groups to the user as follows:

a. Select the newly created user Mobile CRA-admin and navigate to Groups.

b. Assign groups to this user. For example, Administrator and BI Administrator.

9. Click Save to save the user profile.
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10. Test the user by navigating to the OBIEE Analytics site (for example, 
http://<servername>/analytics).

11. Enter the user name and password.

You should be able to log in to OBIEE.

12. Create a new analysis. 

If you see the following subject areas, it indicates that your RPD and user are 
configured and deployed correctly.

Figure 3–15 Select Subject Area Screen

3.9 Deploying Mobile Clinical Research Associate Server Pre-defined 
Alert

To deploy Mobile CRA Server pre-defined alert, perform the following:

1. Log in to the OBIEE Analytics. 

2. Navigate to Catalog.

The Catalog Screen is displayed.

Figure 3–16 Catalog Screen

3. Select Shared Folders and click Unarchive in the bottom-left Tasks menu.
3-10 Oracle Health Sciences Mobile Clinical Research Associate Server Installation and Configuration Guide



Deploying Mobile Clinical Research Associate Server Reports Alert
Figure 3–17 Tasks Menu

4. Click Browse and select the Mobile CRA.catalog file.

Figure 3–18 Selecting the Mobile CRA.catalog File

5. Click OK to unarchive the catalog.

Figure 3–19 Unarchive Window

6. Navigate to Shared Folders and select Mobile CRA to see the predefined alert 
imported.

Figure 3–20 List of Predefined Alert Imported

3.10 Deploying Mobile Clinical Research Associate Server Reports Alert
To deploy Mobile CRA Server Reports alert, perform the following:
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1. Log in to the OBIEE Analytics. 

2. Navigate to Catalog.

The Catalog Screen is displayed.

Figure 3–21 Catalog Screen

3. Select Shared Folders and click Unarchive in the bottom-left Task menu.

Figure 3–22 Tasks Menu

4. Click Browse and select the Mobile CRA.catalog file.

5. Click OK to unarchive the catalog.

Figure 3–23 Unarchive Window

6. Navigate to Shared Folders and select Mobile CRA to see the predefined alert 
imported.
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Figure 3–24 List of Predefined Alert Imported

3.11 Updating OCDA with Mobile Clinical Research Associate Server 
Rules Engine

This section contains the following topics:

■ Section 3.11.1, "Opening OCDA Repository"

■ Section 3.11.2, "Adding Mobile Clinical Research Associate Server Rule Engine 
Data Source (Physical Layer)"

■ Section 3.11.3, "Creating Joins Between Mobile Clinical Research Associate Server 
and OCDA Tables (Physical Layer)"

■ Section 3.11.4, "Creating Mobile Clinical Research Associate Server Sources to 
OCDA Dimensions in the Business Model and Mapping Layer"

■ Section 3.11.5, "Creating Presentation Tables for Mobile Clinical Research Associate 
Server (Presentation Layer)"

■ Section 3.11.6, "Saving the Repository"

3.11.1 Opening OCDA Repository
To open OCDA RPD, perform the following:

1. Open the Oracle Business Intelligence Enterprise Edition Administration tool.

Figure 3–25 Opening Administration Tool

2. Open the OCDA repository (for example, OCDA_21_final.rpd).
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Figure 3–26 Opening OCDA RPD

3. Enter the repository password when prompted.

OCDA RPD will be loaded in the OBIEE Administration tool. 

Figure 3–27 Loaded OCDA RPD

4. Save this RPD and note down the file name (for example, OCDA_MCRE_01.rpd) 
and the location. 

3.11.2 Adding Mobile Clinical Research Associate Server Rule Engine Data Source 
(Physical Layer)

1. From the File menu, select Import Metadata.

Figure 3–28 Selecting Import Metadata
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2. Select OCI 10g/11g in the Connection type.

Figure 3–29 Selecting Connection Type

3. Enter complete data source name, database user name, and password in the 
respective fields. Oracle recommends the following data source name format:

(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<hostname>)(PORT=<port>))(CON
NECT_DATA=(SID=<oracle db sid>)))

Figure 3–30 Entering DB Connection Information

4. Click Next.

5. Select Views from the Metadata types to be imported.

Figure 3–31 Selecting Views

6. Click Next.

7. Select the Mobile CRA Server Rule Engine Schema user from the list and select the 
following View object from the list:

■ HSM_OBI_STUDY_VW

■ HSM_OBI_STUDY_SITE_VW
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Figure 3–32 Selecting Metadata Objects

8. Rename the data source to Mobile CRA Database.

9. Rename the Physical schema to Mobile CRA.

Figure 3–33 Renaming Physical Schema

10. Right-click HSM_OBI_STUDY_VW and select Update Row Count.

11. Right-click HSM_OBI_STUDY_SITE_VW and select Update Row Count.

3.11.3 Creating Joins Between Mobile Clinical Research Associate Server and OCDA 
Tables (Physical Layer)

To create joins between Mobile CRA Server and OCDA tables, perform the following:

1. Create Join for HSM_OBI_STUDY_VW.

a. Select HSM_OBI_STUDY_VW from MobileCRA schema in the MobileCRA 
Database and Dim _W_RXI_STUDY_D from RXI schema in the OCDA Data 
Warehouse.

Figure 3–34 Selecting Files

b. From the View menu, select Physical Diagram, and then Selected Object(s) 
only.
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Figure 3–35 View Menu

c. Click New Join.

d. Click HSM_OBI_STUDY_VW and drag the cursor (hold the mouse) to Dim_
W_RXI_STUDY_D and release the cursor (release the mouse).

Figure 3–36 Creating Join

e. Select INTEGRATION_ID column from the Dim_W_RXI_STUDY_D table 
and STUDY_ID column from the HSM_OBI_STUDY_VW table (view).
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Figure 3–37 Physical Foreign Key Screen

f. Click OK.

g. Close the window.

2. Create Join for HSM_OBI_STUDY_SITE_VW.

The following steps are similar to creating join for HSM_OBI_STUDY_VW in step 
1.

a. Select HSM_OBI_STUDY_SITE_VW from the MobileCRA schema in the 
MobileCRA Database and Dim _W_RXI_STUDY_SITE_D from the RXI 
schema in the OCDA Data Warehouse.

b. From the View menu, select Physical Diagram, and then select Selected 
Object(s) only.

c. Click New Join.

d. Click HSM_OBI_STUDY_SITE _VW and drag the cursor (hold the mouse 
button) to Dim_W_RXI_STUDY_SITE _D and release the cursor (release the 
mouse button).
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Figure 3–38 Creating Join for HSM_OBI_STUDY_SITE _VW

e. Select INTEGRATION_ID column from the Dim_W_RXI_STUDY_SITE_D 
table and STUDY_SITE_ID column from the HSM_OBI_STUDY_SITE_VW 
table (view).

Figure 3–39 Physical Foreign Key Screen

f. Click OK.

g. Close the window.
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3.11.4 Creating Mobile Clinical Research Associate Server Sources to OCDA 
Dimensions in the Business Model and Mapping Layer

To create Mobile CRA Server sources to OCDA Dimensions in the Business Model and 
Mapping Layer, perform the following:

1. Update Dim - Study.

a. Select OCDA-DM and expand by clicking +.

Figure 3–40 Selecting OCDA-DM

b. Select Dim - Study and expand by clicking +.

Figure 3–41 Selecting Dim - Study

c. Click Sources and expand by clicking +.

Figure 3–42 Selecting Source

d. Drag HSM_OBI_STUDY_VW from the Physical section and drop on Dim - 
Study in the Business Model and Mapping section.

Figure 3–43 Drag and Drop

e. Select HSM_OBI_STUDY_D in Sources under Dim - Study.

f. From the Edit menu, select Properties to open property window.

g. Click Add to create join with Dim - Study.
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Figure 3–44 Creating Join

h. Click Dim_W_RXI_STUDY_D from the right side and then click Select.

Figure 3–45 Selecting File

2. Update Dim - Study-Site.

a. Select Dim - Study-Site and expand by clicking +.

Figure 3–46 Selecting Dim - Study

b. Click Sources and expand by clicking +.

c. Drag HSM_OBI_STUDY_SITE_VW from the Physical section and drop on 
Dim - Study-Site in the Business Model and Mapping section.
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Figure 3–47 Drag and Drop

d. Select HSM_OBI_STUDY_SITE_D in Sources under Dim - Study.

e. From the Edit menu, select Properties to open property window.

f. Click Add to create join with Dim - Study-Site.

Figure 3–48 Creating Join

g. Click Dim_W_RXI_STUDY_D from the right side and then click Select.

Figure 3–49 Selecting File

h. Click OK to close the window.

The created join is displayed.
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Figure 3–50 Updated Table

3. Create Custom Columns for HSM_OBI_STUDY_VW.

a. Create four new columns as follows:

SUBSCRIPTION LAST_UPDATED_BY

SUBSCRIPTION LAST_CREATION_DATE

SUBSCRIPTION CREATION_DATE 

SUBSCRIPTION CREATED_BY

b. Map these columns to LAST_UPDATED_BY, LAST_UPDATE_DATE, 
CREATION_DATE, and CREATED_BY respectively from HSM_OBI_STUDY_
VW.

c. Click Add New Column.

Figure 3–51 Logical Table Source

d. Enter the column name, for example, SUBSCRIPTION LAST_UPDATED_BY, 
and update the column mapping to select the correct source.
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Figure 3–52 Logical Column Screen

e. Update the Physical Table as HSM_OBI_STUDY_VW and Expression as 
LAST_UPDATED_BY.

f. Repeat Step 5 for LAST_UPDATE_DATE, CREATION_DATE, and CREATED_
BY columns as shown in the Figure 3–53.

Figure 3–53 Update Logical Column

g. Click OK.

4. Create Custom Columns for HSM_OBI_STUDY_SITE_VW.

a. Create custom columns for LAST_UPDATED_BY, LAST_UPDATE_DATE, 
CREATION_DATE and CREATED_BY columns as shown in Figure 3–54.

b. Map these columns to LAST_UPDATED_BY, LAST_UPDATE_DATE, 
CREATION_DATE, and CREATED_BY respectively from HSM_OBI_STUDY_
VW.

c. Add a new column INTEGRATION_ID mapped to INTEGRATION_ID of 
Dim_W_RXI_STUDY_SITE_D.

d. Follow similar steps defined in Step 3 (Create Custom Columns for HSM_
OBI_STUDY_VW). 

Figure 3–54 Update Logical Column
3-24 Oracle Health Sciences Mobile Clinical Research Associate Server Installation and Configuration Guide



Updating OCDA with Mobile Clinical Research Associate Server Rules Engine
3.11.5 Creating Presentation Tables for Mobile Clinical Research Associate Server 
(Presentation Layer)

To create presentation tables for Mobile CRA Server (presentation layer), perform the 
following:

1. Create New Presentation Table for Grouping Purpose.

a. Right-click OCDA in the Presentation section and then click New 
Presentation Table.

Figure 3–55 Selecting New Presentation Table

b. Enter Mobile CRA Alert Engine in the Name field and click OK.

Figure 3–56 Entering Name

c. Locate the newly created presentation table (that is, Mobile CRA Alert Engine) 
in the Presentation section, and then locate Fact for Presentation Foldering.

d. Drag and drop it on the Mobile CRA Alert Engine table in the presentation 
section.

2. Create New Presentation Table for Study.

1. Right-click OCDA in the Presentation section and then click the New 
Presentation table.

2. Enter - Study in the Name field and click OK.

3. Select the following columns from Dim - Study in the Business Model and 
Mapping section and drop on - Study presentation table in the Presentation 
section.

HSM_RULE_SBSCRTIONS_ID

USER_ID

HSM_RULES_ID

HSM_RULES_NAME
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HSM_RULES_DESCR

HSM_RULES_FNCTN

STUDY_ID

ACTV_STUS

FIRED_STUS

THRESH_DT1

THRESH_DT1_NM

THRESH_DT2

THRESH_DT2_NM

THRESH_DT3

THRESH_DT3_NM

THRESH_DT4

THRESH_DT4_NM

THRESH_DT5

THRESH_DT5_NM

THRESH_NUM1

THRESH_NUM1_NM

THRESH_NUM2

THRESH_NUM2_NM

THRESH_NUM3

THRESH_NUM3_NM

THRESH_NUM4

THRESH_NUM4_NM

THRESH_NUM5

THRESH_NUM5_NM

THRESH_STR1

THRESH_STR1_NM

THRESH_STR2

THRESH_STR2_NM

THRESH_STR3

THRESH_STR3_NM

THRESH_STR4

THRESH_STR4_NM

THRESH_STR5

THRESH_STR5_NM

SUBSCRIPTION LAST_UPDATED_BY

SUBSCRIPTION LAST_UPDATE_DATE
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SUBSCRIPTION CREATION_DATE

SUBSCRIPTION CREATED_BY

3. Create New Presentation Table for Study-Site.

1. Right-click OCDA in the Presentation section and then click New 
Presentation Table.

2. Enter - Study Site in the Name field and click OK.

3. Select the following columns from Dim - Study-Site in the Business Model and 
Mapping section and drop on - Study Site presentation table in the 
Presentation section. 

HSM_RULE_SBSCRTIONS_ID

USER_ID

HSM_RULES_ID

HSM_RULES_NAME

HSM_RULES_DESCR

HSM_RULES_FNCTN

STUDY_SITE_ID

ACTV_STUS

FIRED_STUS

THRESH_DT1

THRESH_DT1_NM

THRESH_DT2

THRESH_DT2_NM

THRESH_DT3

THRESH_DT3_NM

THRESH_DT4

THRESH_DT4_NM

THRESH_DT5

THRESH_DT5_NM

THRESH_NUM1

THRESH_NUM1_NM

THRESH_NUM2

THRESH_NUM2_NM

THRESH_NUM3

THRESH_NUM3_NM

THRESH_NUM4

THRESH_NUM4_NM

THRESH_NUM5

THRESH_NUM5_NM
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THRESH_STR1

THRESH_STR1_NM

THRESH_STR2

THRESH_STR2_NM

THRESH_STR3

THRESH_STR3_NM

THRESH_STR4

THRESH_STR4_NM

THRESH_STR5

THRESH_STR5_NM

SUBSCRIPTION LAST_UPDATED_BY

SUBSCRIPTION LAST_UPDATE_DATE

SUBSCRIPTION CREATION_DATE

SUBSCRIPTION CREATED_BY

4. Create a new column Src Unique Site ID in Study-Site, which is mapped to 
logical column INTEGRATION_ID of Dim_Study Site created in Section 3.11.4, 
"Creating Mobile Clinical Research Associate Server Sources to OCDA 
Dimensions in the Business Model and Mapping Layer" (Step 4).

3.11.6 Saving the Repository
To save the RPD, perform the following:

1. From the File menu, select Save.

3.12 Deploying Site-At-a-Glance Reports
To deploy site-at-a-glance reports, perform the following:

1. Log in to OBIEE analytics. 

2. Navigate to Catalog.

Figure 3–57 Navigating to Catalog

3. Select Shared folders and click Unarchive in the bottom-left Task menu.

4. Click Browse and choose the Site-At-A-Glance-.catalog file.
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Figure 3–58 Selecting Site-At-A-Glance-.catalog File

5. Click OK to unarchive the catalog.

6. Navigate to the Shared folder and select Site-At-A-Glance. 

A list of predefined reports that are imported is displayed which will be deployed.
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4Configuring the Oracle WebLogic Server for 

Mobile Clinical Research Associate Server

This chapter includes the following sections:

■ Section 4.1, "Configuring Oracle WebLogic Server"

■ Section 4.2, "Configuring Security Using Enterprise Manager"

■ Section 4.3, "Setting Up Oracle Advanced Queuing"

■ Section 4.4, "Setting Up the Log Level"

■ Section 4.5, "Updating the Log Level"

4.1 Configuring Oracle WebLogic Server
You need to define a data source to point the WebLogic Server (WLS) to the database 
where the Mobile CRA Server database component is installed.

This section contains the following topics:

■ Section 4.1.1, "Configuring Data Source Mobile Server"

■ Section 4.1.2, "Configuring Data Source Alert Engine"

■ Section 4.1.3, "Installing the Mobile CRA Server"

■  Section 4.1.4, "Customizing the Configuration File"

4.1.1 Configuring Data Source Mobile Server
To configure data source mobile server, perform the following:

1. Log in to Oracle WebLogic Server (WLS) as admin by entering the URL (for 
example,  http://<server:port number>/console). 

2. Click Lock and Edit in the Change Center panel on the left side.

3. Click Services in the Domain Structure window.

4. Select Data Sources.

The Summary of JDBC data sources is displayed on the right-side window panel.

5. Click New and select Generic Data Source from the list.

Note: For information about installing Oracle WebLogic Server, see 
http://docs.oracle.com/cd/E17904_01/doc.1111/e14142/toc.htm. 
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6. In the JDBC Data Source Properties screen, perform the following:

a. Enter the name.

Oracle recommends that the name should match the JNDI name.

b. Enter jdbc/mobilecra as the JNDI name.

c. Enter Oracle as the database type.

d. Click Next. 

e. In the Database Driver field, select the default value, that is, Oracle's Driver 
(Thin XA) for instance connections (versions: 9.0.1 and above).

f. Click Next.

7. Click Next on the Transaction Options screen.

8. In the Connection Properties screen, perform the following: 

a. Enter the SID in the Database Name field. 

b. Enter the server where mobile server database is hosted.

c. Enter the port number for the database.

d. Enter the Mobile CRA server database user name where it is hosted.

e. Enter password for the database user. 

f. Re-enter the password in the Confirm password field.

g. Click Next. 

The Properties, System Properties, and Test Table Name fields are displayed 
on the screen. 

h. Click Test Configuration. 

If the test is successful, the message Connection test succeeded is displayed 
on the screen.

i. Click Next.

The Select Targets screen is displayed with the list of servers. 

9. Select the server where the Mobile CRA Server is installed.

10. Click Finish.

11. After creating jdbc/mobilecra, click Activate Changes in the Change Center 
panel.

4.1.2 Configuring Data Source Alert Engine
To configure data source alert engine, perform the following:

1. Log in to WLS as admin by entering the URL (for example, http://<server:port 
number>/console). 

2. Click Lock and Edit in the Change Center panel on the left side.

3. Click Services in the Domain Structure window.

4. Select Data Sources.

The Summary of JDBC Data Sources is displayed on the right-side window panel.

5. Click New and select Generic Data Source from the list.
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6. In the JDBC Data Source Properties screen, perform the following:

a. Enter the name.

Oracle recommends that the name should match the JNDI name.

b. Enter jdbc/ae as the JNDI name.

c. Enter Oracle as the database type.

d. Click Next. 

e. In the Database Driver field, select the default value, that is, Oracle's Driver 
(Thin XA) for instance connections (versions: 9.0.1 and above).

f. Click Next. 

7. Click Next on the Transaction Options screen.

8. In the Connection Properties screen, perform the following: 

a. Enter the SID in the Database Name field. 

b. Enter the server where alert engine database is hosted.

c. Enter the port number for database.

d. Enter the alert engine database user name where it is hosted.

e. Enter password for the database user. 

f. Re-enter the password in the Confirm password field.

g. Click Next. 

The Properties, System Properties, and Test Table Name fields are displayed 
on the screen. 

h. Click Test Configuration. 

If the test is successful, the message Connection test succeeded is displayed 
on the screen.

i. Click Next.

The Select Targets screen is displayed with the list of servers. 

9. Select the server where the Mobile CRA Server is installed.

10. Click Finish.

11. After creating jdbc/ae, click Activate Changes in the Change Center panel.

12. Exit the Oracle WebLogic server.

4.1.3 Installing the Mobile CRA Server

4.1.3.1 Installing oracle.hs.Mobile CRA.cda.war on Oracle WebLogic Server 
To install oracle.hs.Mobile CRA.cda.war on WebLogic server, perform the following:

1. Download Mobile CRA_Server_CDA_Adapter.zip to a local folder and unzip it 
to extract the oracle.hs.Mobile CRA.cda.war file. 

2. Log in to the Oracle WebLogic Server Administration Console.

3. Within Server Administration, select Deployments.
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Figure 4–1 Selecting Deployments

The Summary of Deployments screen is displayed.

4. Select Install to install the application.

5. Browse the directory where the install package is located.

Figure 4–2 Browsing the Directory

6. Select the oracle.hs.Mobile CRA.cda.war file.

7. Select the Install this deployment as a library option.
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Figure 4–3 Selecting the Targeting Style

8. Select default settings as displayed in Figure 4–4.

Figure 4–4 Selecting the Default Settings

9. Select Finish to complete installation.

10. Click Activate Changes.

4.1.3.2 Installing oracle.hs.Mobile CRA.ctms.war on Oracle WebLogic Server 
To install oracle.hs.Mobile CRA.ctms.war on WLS, follow the similar steps in 
Section 4.1.3.1, "Installing oracle.hs.Mobile CRA.cda.war on Oracle WebLogic Server".

4.1.3.3 Installing oracle.hs.Mobile CRA.ear on Oracle WebLogic Server 
To install oracle.hs.Mobile CRA.ear on WLS, perform the following:

1. Log in to the Oracle WebLogic Server Administration Console.
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2. Within Server Administration, select Deployments.

The Summary of Deployments screen is displayed.

3. Select Install to install the application.

4. Browse the directory where the install package is located.

5. Select the oracle.hs.Mobile CRA.ear file.

6. Select the Install this deployment as an application option.

7. Select default settings as displayed in Figure 4–5.

Specify the name as oracle.hs.mobilecra.

Figure 4–5 Selecting the Default Settings

8. Select Finish to complete installation.

9. Click Activate Changes.

4.1.4 Customizing the Configuration File
To customize the configuration file, perform the following:

1. From the File system, locate Config.xml under Config folder of the main folder. 

This is a template file where you have to update values for customization.

2. Create a copy of Config.xml and save it as Plan.xml. 

For examples of Config.xml and Plan.xml files, see Appendix B.2. 

3. Modify configuration values for your environment. 

The plan.xml file lets you configure your Mobile CRA Server application to point 
to the right CTMS and OCDA server, push notification schedule, alert engine 
schedule, and so on.
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Some of the basic configurations such as CTMS server information has to be setup 
for the application to work but the advanced configuration such as push 
notification configurations may be modified to suit your schedule and 
performance needs.

Following are the basic settings to change in the Plan.xml file:

■ ctmsApdater.hostname -The name of the CTMS host to which the mobile 
instance should connect for accessing and manipulating data. For example, 
server.domain.com.

■ ctmsAdpater.port - The CTMS port host. For example, 8080. If the default 
port is used, enter a value 0 instead of null.

■ cdaFeaturedAdapter.wsdlLocation - This is the URL of the OBIEE Web 
service wsdl location. Mobile CRA Server uses the OBIEE server for alerts and 
notifications. For example, http://<localhost>/analytics/saw.dll?WSDL.

■ pushNotificationService.url - If you are using alerts and notifications, use 
this to set the URL of the push notification service. This is the URL of the 
hosted service provided by Oracle. For example, 
https://<servername>/notificationservice.

■ notificationEngineScheduler.period and 
notificationEngineScheduler.timeUnit - If you use alerts and notifications, 
use this to set the schedule for the notification engine.

notificationEngineScheduler.period along with 
notificationEngineScheduler.timeUnit defines the schedule for the notification 
scheduler. A value of 300 for notificationEngineScheduler.period along with a 
value of seconds for notificationEngineScheduler.timeUnit specifies a 
schedule of 300 seconds. Valid values for 
notificationEngineScheduler.timeUnit are seconds, minutes, and hours.

Advanced settings:

■ pushNotificationEngine.maximumPoolSize - The maximum number of 
threads in the pool for the push notification engine. The valid values are 
integer values.

■ pushNotificationEngine.engineLockTimeout - The duration the service 
should wait for the push notification engine to respond.

■ notificationEngineScheduler.initialDelay - The initial delay after which 
the notification starts after each WLS restart.

4. Save Plan.xml to the machine where Oracle WebLogic is installed. 

5. Upload Plan.xml file on the server as follows: 

a. In the Deployments table, select oracle.hs.Mobile CRA.

b. Click Update.

Note: The same settings are applicable for Alert Engine Scheduler.
Configuring the Oracle WebLogic Server for Mobile Clinical Research Associate Server 4-7



Configuring Oracle WebLogic Server
Figure 4–6 Deployments Table

c. In the Update Application Assistant wizard, select Update this application in 
place with new deployment plan changes, and click Change Path. 

Figure 4–7 Changing the Deployment Plan Path

d. In the Path field, specify the deployment path of your environment specific 
Plan.xml file to upload it to the server.
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Figure 4–8 Specifying the Deployment Path

e. Click Finish.

4.2 Configuring Security Using Enterprise Manager
For information about configuring security using Enterprise Manager, see Oracle 
Health Sciences Mobile Clinical Research Associate Server Security Guide.

4.3 Setting Up Oracle Advanced Queuing
Mobile CRA Server uses Oracle AQ to send and receive asynchronous messages. 
Complete the following setup to configure Mobile CRA Server to use Oracle AQ.

1. Navigate to Services, select Messaging, and then select JMS Modules.

The JMS Module screen is displayed.
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Figure 4–9 JMS Module Screen

2. Click Lock and Edit.

3. Click New to create a new JMS module.

The Create JMS System Module screen is displayed.

4. Enter McraJmsSysMod as the name of your system module.

Figure 4–10 Creating a New JMS Module
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5. Enter a descriptor file name (optional). 

If you do not provide the descriptor file name, a default file name is assigned.

6. Specify the location where you may want to place the descriptor of this system 
module (optional).

7. Click Next.

8. In the Targets section, select the server or cluster on which you want to deploy this 
JMS system module. 

Figure 4–11 Selecting Target Server

9. Click Next.

10. Select Would you like to add resources to this JMS system module? if you want 
to add resources.

Figure 4–12 Adding Resources to the JMS System Module

11. Click Next.

The list of resources type is displayed.

12. Select Foreign Server as the resource.
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Figure 4–13 Selecting Type of Resource

The Foreign Server Properties screen is displayed.

13. Enter OracleAQFS as the foreign server name.

Figure 4–14 Foreign Server Properties

14. Click Next.

The Targets screen is displayed. Accept the default targets where the JMS resource 
is targeted.
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Figure 4–15 Accepting Default Target

The foreign server is created successfully.

15. Click Finish.

16. In the Setting for OracleAQFS screen, select the Configuration tab.

17. Select the General subtab and enter the JNDI initial context factory name as 
oracle.jms.AQjmsInitialContextFactory.

18. Click Save to save the settings.

A message is displayed indicating that the settings are updated.

19. Select the Destinations subtab and enter the foreign destination properties in the 
Create a New Foreign JMS Destination screen.

Name: jms/aq/tripReportQueue

JNDI Name: jms/aq/tripReportQueue

Remote JNDI Name: Queues/<schema>, in which mobileaq is installed.

mobileaq.trip_report_queue is the table that queues the trip report in the 
schema.

20. Select Connection Factories subtab and enter the foreign connection factory 
properties in the Create a New Foreign JMS Connection Factory screen.

Name: /jms/aq/mobileQueueCF

Local JNDI Name: /jms/aq/mobileQueueCF

Remote JNDI Name: XAQueueConnectionFactory

21. Click OK.

22. Click Activate Changes.

23. Restart for changes to take effect.

4.4 Setting Up the Log Level
To set up the log level in the server, perform the following: 
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1. Log in to Enterprise Manager (for example, http://<server:port number>/em).

2. Navigate to WebLogic Domain, select alerts_domain, and then select Admin 
Server.

3. From the WebLogic Server drop-down list, select Logs, and then select Log 
Configuration.

Figure 4–16 Selecting Log Configuration

The Log Configuration screen is displayed.

4. In the Log Levels tab, expand Root Logger in the Logger Name column.

5. Expand the package for which the log level needs to be set.

Note: These settings are not persistent and will reset if you restart 
the server.
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Figure 4–17 Log Configuration Screen

4.5 Updating the Log Level
You can update the log file name and path in the Config.xml file. 

For example,

<property name="Mobile CRALogFile" 
value="${domain.home}/servers/${weblogic.Name}/logs/Mobile CRA.log"/>

Property name: Mobile CRALogFile 

Path: "${domain.home}/servers/${weblogic.Name}/logs/Mobile CRA.log"

Log file name: Mobile CRA.log
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5Deploying the Mobile Clinical Research 

Associate Server Administration Application

This chapter details the deployment of the Mobile CRA Server Administration 
application. It includes the following sections: 

■ Section 5.1, "Verifying the Installation Package"

■ Section 5.2, "Configuring Data Sources for Mobile Clinical Research Associate 
Server"

■ Section 5.3, "Configuring Security for Mobile Clinical Research Associate Server"

■ Section 5.4, "Using Single Sign On and Lightweight Directory Access Protocol for 
Mobile Clinical Research Associate Server"

■ Section 5.5, "Deploying Mobile Clinical Research Associate Server Application"

■ Section 5.6, "Verifying Deployment"

5.1 Verifying the Installation Package
You must validate the installation package before deploying. To validate, ensure that:

■ The Install package is deployed as an Enterprise Archive file called Mobile CRA_
AdminUI_v#.ear.

■ The EAR file contains ADF related application files.

■ The EAR file also includes the WAR file, which contains the actual web 
application.

■ The file name contains the build version as mentioned in the Release Notes.

5.2 Configuring Data Sources for Mobile Clinical Research Associate 
Server

To configure data sources for Mobile CRA Server, you need:

■ Two data sources for the Mobile CRA Server Administration application. 

■ Mobile OCDA data source for the configuration of the Mobile Alert Notification 
adapter.

Note: For deploying the Mobile CRA Server application, see Oracle 
WebLogic Administration Guide.
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■ Mobile CTMS data source for the configuration of the Mobile Trip Report adapter.

To create the data sources in the WebLogic Administration Console, perform the 
following:

1. Within the Server Administration Console, select Data Sources under Services.

Figure 5–1 Server Administration Console

The Summary of JDBC Data Sources screen is displayed.

2. Select New and then select Generic Data Source from the drop-down list.

Figure 5–2 Summary of JDBC Data Sources Screen

The Create a New JDBC Data Source screen is displayed.

3. Enter jdbc/mobilecda as the name and JNDI name to connect to MCRE_ADMIN 
schema.
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Figure 5–3 Creating a New JDBC Data Source Screen

4. Select database driver as Oracle Driver (Thin XA) (versions: 9.0.1 and later).

Figure 5–4 Selecting Database Driver

5. Select default settings as displayed in Figure 5–5.

Figure 5–5 Selecting Default Settings

Note: In case the WebLogic Server version is 10.3.6.0 (the default is 
10.3.5.0), jdbc/mobilecda should select Oracle's Driver (Thin) during 
the installation. 
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6. Configure connection properties as displayed in Figure 5–6.

Figure 5–6 Configuring Connection Properties

7.  Upon completion, select Test Configuration to validate the connection.
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Figure 5–7 Selecting Test Configuration

The Connection test succeeded message is displayed.

8. Repeat Step 3. 

Enter jdbc/mobilectms name as JNDI name to connect to MCTR_ADMIN 
schema.
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Figure 5–8 Creating a New JDBC Data Source Screen

9. After creating both data sources, the Summary of JDBC Data sources screen is 
displayed with the newly created data sources.

Figure 5–9 Summary of JDBC Data sources Screen

Note: In case the WebLogic Server version is 10.3.6.0 (the default is 
10.3.5.0), jdbc/mobilectms should select Oracle's Driver (Thin) 
during the installation. 

Also, the jdbc/mobilectms datasource should have Emulate 
Two-Phase Commit selected.
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5.3 Configuring Security for Mobile Clinical Research Associate Server
For information about configuring security for Mobile CRA Server, see Oracle Health 
Sciences Mobile Clinical Research Associate Server Security Guide.

5.4 Using Single Sign On and Lightweight Directory Access Protocol for 
Mobile Clinical Research Associate Server

To use Single Sign On (SSO) and Lightweight Directory Access Protocol (LDAP), see 
the following documents:

■ http://docs.oracle.com/cd/E29306_01/index.htm

■ http://docs.oracle.com/cd/E27559_01/index.htm

5.5 Deploying Mobile Clinical Research Associate Server Application
To deploy Mobile CRA Server application, perform the following:

1. Log in to the Oracle WebLogic Server Administration Console.

2. Within Server Administration, select Deployments.

Figure 5–10 Selecting Deployments

Note: For validating data source content, see Mobile CRA Server 
Database Deployment guide.
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The Summary of Deployments screen is displayed.

3. Select Install to deploy application.

Figure 5–11 Summary of Deployments Screen

4. Browse the directory where the install package is located.

Figure 5–12 Browsing the Directory

5. Select the Mobile CRA_AdminUI_v#.ear file.
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Figure 5–13 Selecting the Default File

6.  Select the Install this deployment as an application option.

Figure 5–14 Choosing the Targeting Style

7. Select default settings as displayed in Figure 5–15.
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Figure 5–15 Selecting the Default Settings

8. Select Finish to complete installation.
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Figure 5–16 Selecting Finish

9. Validate that the installed application is listed on the Deployments screen.

Figure 5–17 Validating the Application 
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5.6 Verifying Deployment
To verify deployment, perform the following:

1. Enter the following URL for the Mobile CRA Server application:

http://<server:port>/MobileAdminCRA/faces/login.jspx?

The Login page is displayed.

Figure 5–18 Login Page

2. Enter the user name and password.

The Mobile CRA Home page is displayed.

Figure 5–19 The Mobile CRA AdminUI Home Page
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6Mobile Clinical Research Associate Server 

Application Setup

You must download and install the Mobile application for iPad or iPhone from the 
App store. This chapter details the set up of Mobile CRA Server. It includes the 
following sections:

■ Section 6.1, "Setting Up Mobile Clinical Research Associate Server for iPad"

■ Section 6.2, "Setting Up Mobile Clinical Research Associate Server for iPhone"

6.1 Setting Up Mobile Clinical Research Associate Server for iPad

6.1.1 Setting Up the Server
To set up the Mobile CRA server, perform the following:

1. Navigate to the iPad Home screen.

2. Tap Settings.

3. Tap Mobile CRA.

The Mobile CRA screen is displayed.

4. Set the idle time for a session in the Time out field. Once this specified amount of 
time has passed, you will be logged off from your Mobile CRA Server session.

5. Enter the server address in the format, http://hostname:port or 
https://hostname:port.

6.1.2 Running and Logging to the Application
To run and log in to the application, perform the following:

1. Click Home.

2. Tap Mobile CRA.

3. On the Login screen, enter the user ID and password.

4. Tap Login.

6.2 Setting Up Mobile Clinical Research Associate Server for iPhone
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6.2.1 Setting Up the Server
To set up the Mobile CRA Server, perform the following:

1. Navigate to the iPhone Home screen.

2. Tap Settings.

3. Tap Mobile CRA.

The Mobile CRA screen is displayed.

4. Set the idle time for a session in the Time out field. Once this specified amount of 
time has passed, you will be logged off from your Mobile CRA Server session.

5. Enter the Mobile CRA server address in the format http://hostname:port or 
https://hostname:port.

6. Tap Back.

6.2.2 Running and Logging to the Application
To run and log in to the application, perform the following:

1. Navigate to the Home screen.

2. Tap Mobile CRA.

Wait until the Menu screen is displayed.

3. Tap on the Alerts icon on the menu.

Wait until the Login screen is displayed.

4. On the Login screen, enter the user ID and password.

5. Tap Login.
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ASample Scripts

This appendix provides the following sample SQL scripts:

■ Appendix A.1, "Create_user.sql"

■ Appendix A.2, "Create_queue_tables.sql"

A.1 Create_user.sql
Use the following script to create the user. The script prompts for the password.

create user mobileaq identified by &&mobileaq_pwd;
 
grant connect, resource to mobileaq;
 
grant aq_user_role to mobileaq;
 
Grant execute ON sys.dbms_aqadm TO mobileaq;
 
Grant execute ON sys.dbms_aq TO mobileaq;
 
Grant execute ON sys.dbms_aqin TO mobileaq;
 
Grant execute ON sys.dbms_aqjms TO mobileaq;

A.2 Create_queue_tables.sql
DECLARE
po dbms_aqadm.aq$_purge_options_t;
BEGIN
po.block := FALSE;
DBMS_AQADM.PURGE_QUEUE_TABLE(
queue_table => 'TRIP_REPORT_QT',
purge_condition => NULL,
purge_options => po);
END;
 
BEGIN
 
  dbms_aqadm.drop_queue_table('TRIP_REPORT_QT', TRUE, FALSE);
 
  dbms_aqadm.create_queue_table(
     queue_table=>'TRIP_REPORT_QT',
     queue_payload_type=>'sys.aq$_jms_text_message');
 
DBMS_AQADM.CREATE_QUEUE (
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  queue_name => 'trip_report_queue'
, queue_table => 'mobileaq.trip_report_qt'
, queue_type => DBMS_AQADM.NORMAL_QUEUE
, max_retries => 5
, retry_delay => 0
, retention_time => 1800
, dependency_tracking => FALSE
, comment => 'queue for mobile trip report'
, auto_commit => FALSE);
 
DBMS_AQADM.START_QUEUE('trip_report_queue');
 
END;
 
 
CREATE TABLE "TRIP_REPORT_TRACKING"
  (
    "TRACKING_ID"     NUMBER(10,0),
    "USER_ID"        VARCHAR2(80 BYTE),
    "TRIP_REPORT_ID" VARCHAR2(80 BYTE),
    "TEMPLATE_ID"    VARCHAR2(80 BYTE),
    "CTMS_TRIP_REPORT_QRY_REQUEST" CLOB,
    "QUERIED_CANONICAL_TRIP_REPORT" CLOB,
    "CTMS_TRIP_REPORT_UPD_REQUEST" CLOB,
    "TO_UPD_CANONICAL_TRIP_REPORT" CLOB,
    "STATUS"     VARCHAR2(20 BYTE),
    "ERROR_CODE" VARCHAR2(80 BYTE),
    "ERROR_TEXT" VARCHAR2(2000 BYTE),
    "CREATED_BY" VARCHAR2(80 BYTE),
    "CREATION_TS" DATE,
    "MODIFIED_BY" VARCHAR2(80 BYTE),
    "MODIFICATION_TS" DATE,
    "LAST_REQ_OPERATION" VARCHAR2(15 BYTE),
    PRIMARY KEY ("TRACKING_ID")
  );
 
create sequence TRIP_REPORT_TRACKING_SEQ start with 1 increment by 1 maxvalue 
9999999999 cycle;
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This appendix provides the following sample XML files, which you may use to 
customizing the configuration file:

■ Appendix B.1, "Config.xml"

■ Appendix B.2, "Plan.xml"

B.1 Config.xml

<?xml version='1.0' encoding='UTF-8'?>
<deployment-plan xmlns="http://xmlns.oracle.com/weblogic/deployment-plan" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://xmlns.oracle.com/weblogic/deployment-plan 
http://xmlns.oracle.com/weblogic/deployment-plan/1.0/deployment-plan.xsd" 
global-variables="false">
  <application-name>oracle.hs.Mobile CRA.ear</application-name>
  <variable-definition>
    <variable>
      <name>ctmsAdapter.hostname</name>
      <value></value>
    </variable>
    <!-- If port is not defined then default it to 0 -->
    <variable>
      <name>ctmsAdapter.port</name>
      <value></value>
    </variable>
<variable>
      <name>pushNotificationEngine.maximumPoolSize</name>
      <value></value>
    </variable>
<variable>
      <name>pushNotificationEngine.timeUnit</name>
      <value></value>
    </variable>
<variable>
      <name>pushNotificationEngine.engineLockTimeout</name>
      <value></value>
    </variable>
<variable>
      <name>notificationEngineScheduler.initialDelay</name>
      <value></value>
    </variable>
<variable>
      <name>notificationEngineScheduler.period</name>
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      <value></value>
    </variable>
<variable>
      <name>notificationEngineScheduler.timeUnit</name>
      <value></value>
    </variable>
<variable>
      <name>CdaFeaturedAdapter.wsdlLocation</name>
      <value></value>
    </variable>
<variable>
      <name>pushNotificationService.registrationUrl</name>
      <value></value>
    </variable>
<variable>
      <name>pushNotificationService.notificationUrl</name>
      <value></value>
    </variable>
  </variable-definition>
  <module-override>
    <module-name>oracle.hs.Mobile CRA.war</module-name>
    <module-type>war</module-type>
    <module-descriptor external="false">
      <root-element>web-app</root-element>
      <uri>WEB-INF/web.xml</uri>
      <variable-assignment>
        <name>ctmsAdapter.hostname</name>
        
<xpath>/web-app/context-param/[param-name="ctmsAdapter.hostname"]/param-value</xpa
th>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>ctmsAdapter.port</name>
        
<xpath>/web-app/context-param/[param-name="ctmsAdapter.port"]/param-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>pushNotificationEngine.maximumPoolSize</name>
        
<xpath>/web-app/context-param/[param-name="pushNotificationEngine.maximumPoolSize"
]/param-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>pushNotificationEngine.timeUnit</name>
        
<xpath>/web-app/context-param/[param-name="pushNotificationEngine.timeUnit"]/param
-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>pushNotificationEngine.engineLockTimeout</name>
        
<xpath>/web-app/context-param/[param-name="pushNotificationEngine.engineLockTimeou
t"]/param-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
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        <name>SimpleScheduler.initialDelay</name>
        
<xpath>/web-app/context-param/[param-name="notificationEngineScheduler.initialDela
y"]/param-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>SimpleScheduler.period</name>
        
<xpath>/web-app/context-param/[param-name="notificationEngineScheduler.period"]/pa
ram-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>notificationEngineScheduler.timeUnit</name>
        
<xpath>/web-app/context-param/[param-name="notificationEngineScheduler.timeUnit"]/
param-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
  <variable-assignment>
        <name>CdaFeaturedAdapter.wsdlLocation</name>
        
<xpath>/web-app/context-param/[param-name="CdaFeaturedAdapter.wsdlLocation"]/param
-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>pushNotificationService.registrationUrl</name>
        
<xpath>/web-app/context-param/[param-name="pushNotificationService.registrationUrl
"]/param-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>pushNotificationService.notificationUrl</name>
        
<xpath>/web-app/context-param/[param-name="pushNotificationService.notificationUrl
"]/param-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
    </module-descriptor>
  </module-override>
  <config-root></config-root>
</deployment-plan>

B.2 Plan.xml

<?xml version='1.0' encoding='UTF-8'?>
<deployment-plan xmlns="http://xmlns.oracle.com/weblogic/deployment-plan" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://xmlns.oracle.com/weblogic/deployment-plan 
http://xmlns.oracle.com/weblogic/deployment-plan/1.0/deployment-plan.xsd" 
global-variables="false">
  <application-name>oracle.hs.Mobile CRA.ear</application-name>
  <variable-definition>
    <variable>
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      <name>ctmsAdapter.hostname</name>
      <value><servername></value>
    </variable>
<variable>
      <name>ctmsAdapter.port</name>
      <value>0</value>
    </variable>
<variable>
      <name>pushNotificationEngine.maximumPoolSize</name>
      <value>5</value>
    </variable>
<variable>
      <name>pushNotificationEngine.timeUnit</name>
      <value>seconds</value>
    </variable>
<variable>
      <name>pushNotificationEngine.engineLockTimeout</name>
      <value>10</value>
    </variable>
<variable>
      <name>notificationEngineScheduler.initialDelay</name>
      <value>40</value>
    </variable>
<variable>
      <name>notificationEngineScheduler.period</name>
      <value>300</value>
    </variable>
<variable>
      <name>notificationEngineScheduler.timeUnit</name>
      <value>seconds</value>
    </variable>
<variable>
      <name>CdaFeaturedAdapter.wsdlLocation</name>
      <value>http://<servername>/analytics/saw.dll?WSDL</value>
    </variable>
<variable>
      <name>pushNotificationService.registrationUrl</name>
      <value><servername>/notificationservice/registrations</value>
    </variable>
<variable>
      <name>pushNotificationService.notificationUrl</name>
      <value><servername>/notificationservice/notifications</value>
    </variable>
  </variable-definition>
  <module-override>
    <module-name>oracle.hs.Mobile CRA.war</module-name>
    <module-type>war</module-type>
    <module-descriptor external="false">
      <root-element>web-app</root-element>
      <uri>WEB-INF/web.xml</uri>
      <variable-assignment>
        <name>ctmsAdapter.hostname</name>
        
<xpath>/web-app/context-param/[param-name="ctmsAdapter.hostname"]/param-value</xpa
th>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>ctmsAdapter.port</name>
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<xpath>/web-app/context-param/[param-name="ctmsAdapter.port"]/param-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>pushNotificationEngine.maximumPoolSize</name>
        
<xpath>/web-app/context-param/[param-name="pushNotificationEngine.maximumPoolSize"
]/param-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>pushNotificationEngine.timeUnit</name>
        
<xpath>/web-app/context-param/[param-name="pushNotificationEngine.timeUnit"]/param
-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>pushNotificationEngine.engineLockTimeout</name>
        
<xpath>/web-app/context-param/[param-name="pushNotificationEngine.engineLockTimeou
t"]/param-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>SimpleScheduler.initialDelay</name>
        
<xpath>/web-app/context-param/[param-name="notificationEngineScheduler.initialDela
y"]/param-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>SimpleScheduler.period</name>
        
<xpath>/web-app/context-param/[param-name="notificationEngineScheduler.period"]/pa
ram-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>notificationEngineScheduler.timeUnit</name>
        
<xpath>/web-app/context-param/[param-name="notificationEngineScheduler.timeUnit"]/
param-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
  <variable-assignment>
        <name>CdaFeaturedAdapter.wsdlLocation</name>
        
<xpath>/web-app/context-param/[param-name="CdaFeaturedAdapter.wsdlLocation"]/param
-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
        <name>pushNotificationService.registrationUrl</name>
        
<xpath>/web-app/context-param/[param-name="pushNotificationService.registrationUrl
"]/param-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
      <variable-assignment>
Sample XML Files B-5



Plan.xml
        <name>pushNotificationService.notificationUrl</name>
        
<xpath>/web-app/context-param/[param-name="pushNotificationService.notificationUrl
"]/param-value</xpath>
        <operation>replace</operation>
      </variable-assignment>
    </module-descriptor>
  </module-override>
  <config-root></config-root>
</deployment-plan>
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